BAB IV
HASIL DAN PEMBAHASAN

4.1. Hasil

Hasil penelitian ini adalah sebuah LMS yang berbasis website yang terintegrasi
dengan aplikasi berbasis windows melalui sistem API, website ini dibangun dengan
dukungan teknologi moodle versi 3.0.0, halaman yang terdapat dalam website ini

secara umum dibagi menjadi dua yaitu:

- Halaman dashboard admin, digunakan oleh admin yang bertanggung jawab
untuk mengelola konten-konten yang dibutuhkan seperti, membuat course
(mata kuliah), membuat akun yang digunakan oleh mahasiswa_untuk login
website, menambahkan mahasiswa berdasarkan mata kuliah yang diikuti.

- Halaman dashboard user, digunakan oleh mahasiswa untuk mengunduh

SCORM packet dan mengunggah nilai hasil mengerjakan soal.
4.2. Pembangunan Sistem

4.2.1. Instalasi Aplikasi Server

Pembangunan aplikasi ini diawali dengan instalasi server Apache dan MySq|l
menggunakan aplikasi XAMPP, tahapan selanjutnya ialah menjalankan dan
memastikan server Apache dan MySql telah berjalan. Berjalannya server apache dan
Mysql ditandai dengan label nama Apache dan MySql berubah menjadi berwarna hijau
seperti yang terdapat pada gambar 4.1.
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Gambar 4.1 Running Apache dan MySqgl di XAMPP

1.2.2. Instalasi Moodle

Instalasi moodle adalah langkah lanjutan setelah melakukan instalasi aplikasi
XAMPP. Instalasi moodle merupakan pembangunan LMS dalam bentuk interface dan
fungsi yang belum terkonfigurasi termasuk pembuatan database yang akan digunakan

untuk menampung data mahasiswa.
4.3. Fungsi-fungsi Halaman Website IImuku

4.3.1. Halaman Administrator
Halaman administrator adalah halaman yang hanya bisa diakses oleh
administrator website Ilmuku.com. Halaman administrator berfungsi untuk mengatur

semua aktivitas yang digunakan pada sistem.




4.3.1.1. Halaman Home (Beranda)

Gambar 4.2 merupakan halaman home terdiri dari slider dan box Navigation,
Slider memuat gambar Sportorium UMY dan Menara AR. Fahrudin. Box Navigation
memuat berbagai macam courses yang terdapat pada website lImuku.com. Pada sisi

kanan atas terdapat tombol login yang akan mengarahkan admin ataupun mahasiswa

pada halaman login.

Course categories

v Collapse all Home

Courses

Selatan, Tamantirto, Kasihan,

& E-mail: p

Gambar 4.2 Halaman Home (Beranda)



4.3.1.2. Halaman Login
Gambar 4.3. merupakan halaman login website IImuku.com Setelah melakukan

login admin akan masuk ke halaman Dashboard.

Login

Usemame

Password

O Remember usemame

Cookies must be enabled in your browser

tan, Tamantirto, Kasihan,

Gambar 4.3 Halaman Login



4.3.1.3. Halaman Dashboard Administrator

Gambar 4.4 halaman dashboard administrator merupakan halaman utama yang
berisi fitur-fitur yang digunakan admin untuk mengatur tampilan halaman,
menambahkan user (mahasiswa), membuat mata kuliah, melihat nilai mahasiswa,

mengunggah paket SCORM dan membuat aktifitas lain yang terdapat pada moodle.

Navigation Course overview

Dashboard
Site home
Site pages

Courses

Administration

Site administration

Gambar 4.4 Halaman Dashboard Administrator



4.3.1.4. Halaman Course Administrator

Gambar 4.5 merupakan halaman course administrator yang digunakan
administrator untuk membuat kategori dan mata kuliah, dalam kasus ini kategori yang
dimaksud adalah Teknologi informasi dan Kesehatan sedangkan Courses yang

dimaksud adalah nama mata perkuliahan seperti Java dan Pulmonologi.

Navigation Search courses: a

Dashboard Collapse all
Site home
Site pages
Courses

Administration

Site administration

JL. Linkar Selatan, Tamantirto, Kasihan,

Bantul, Yogyakarf

Gambar 4.5 Halaman Courses Administrator

Setelah membuka halaman courses secara otomatis sistem akan memunculkan
blok course administrator. Blok course administrator memiliki beberapa submenu yang

berfungsi mengatur akitivitas pada halaman courses.



Beberapa submenu pada menu course administrator adalah sebagai berikut:

1. Turn editing on: Menu ini berfungsi untuk menambahkan atau menghapus
block pada halaman courses, selain itu menu ini juga berfungsi untuk
mengaktifkan block courses review agar admin bisa merubah nama topik
perkuliahan dan menambahkan aktivitas yang diperlukan, dalam kasus ini
aktivitas yang perlu ditambahkan hanya aktivitas kuis dan paket SCORM.

2. Edit setting: Menu ini berfungsi untuk merubah nama course dan merubah
letak kategori yang berhubungan dengan course.

3. User: Menu ini berfungsi untuk menambahkan user yang telah terdaftar
kedalam mata kuliah.

4. Grades: Menu ini berfungsi untuk melihat nilai mahasiswa pada mata kuliah
terkait.



4.3.1.5. Halaman Topik Perkuliahan

Halaman topik perkuliahan memuat nama materi perkuliahan yang diikuti oleh
mahasiswa. Di dalam topik perkuliahan berisi aktifitas kuis yang berfungsi sebagai
penampung data nilai mahasiswa. Topik perkuliahan juga memuat paket SCORM yang
akan diunduh oleh mahasiswa sebagai bahan untuk memperoleh materi ajar dan kuis.
User interface halaman topik perkuliahan dapat dilihat pada gambar 4.6

Admin User e -

o Feedback Learning Mocdet
Research and Development

Dashboard » Courses » Teknologi informasi » java Turn editing on

Navigation =lal Topic 1
Integer and Floating Data Types
Dashboard 9 9 P

Infeger and Floating Data Types
= Site home B

» Site pages
~ Curent course Topic 2
LA v Character and Boolean Data Types
L [Peli i 2o "7 Character and Boolean Data Types
» Badges
b Topic 1
Topic 3
» Topic 2 P
» Topic 3 w  Literals and Variables
» Topic 4 "7 Literals and Variables
b Topic 5
b Topic & .
o Topic 4
b Topic 7
»  Type Conversions Promotions and Castings
b Topic 8
"7 Type Conversions, Promotions and Castings
» Topic @
» Topic 10
» Courses Topic 5
v Amrays
7 Amays
Administration =lal . 4
~ Course administration
Topic 6
#" Tum editing on
& Edit seftings v Arithmetic Operators
’ ; .
b Users Arithmetic Operators
Y Filters
» Reports Topic 7
Bl Grades o
»  Bitwise Operators
# Gradebook setup - o
. Bitwise Operators
» Badges

Gambar 4.6 Halaman Topik Perkuliahan



4.3.1.6. User

Admin User e =

{Gamme Feedback Learning Model >
Research and Development

Dashboard » Site administration » Users » Accounts » Browse list of users

Navigation Slol 27 Users
~ New fiter
Dashboard
= Site home
} User full name contains B
» Site pages
b Courses
Add filter
. . Show more...
Administration [Blal
First name / Surname: Email address City/town Country Lastaccess  Edit
~ Site administration AbdulHakim Hakim AbdulHakimHakim@gmail.com 12 days 11 X @
hours ™
# Notifications
Aditya Wahyu Prakasa AdityaWahyu Prakasa@gmail.com Never X @
1# Regisiration L4
Admin User purbohadi@yahco.com 53 secs &
## Advanced features
AlvinRyandi Palham Ryandi Palham AninRyandi PalhamRyandi Palham@gmail.com Never X @
¥ Users &
Ayu Humaira AyuHumaira@gmail.com Never X @
~ Accounts
-
4# Browse list of users Bagus Pribadi BagusPribadi@gmail.com Never X @
&
## Bulk user actions
Baiatur Ridhwana Nur R BaioturRidhwana Nur R@gmail.com Never X @
£+ Add a new user ®
Bhaskoro Wicaksono BhaskoroWicaksono@gmail.com Never X @
¥ User default ™
references
2 Docidy Kariiandy DodclyKarliandy@gmail.com 3days 11 X @
4% User profile fields LD L4
Fagih Arief Ramadhan FagihArief Ramadhan@gmail.com Never X @
# Cohorts 5
2 Upload users InayahMufidah Mufidah InayahMufidahMufidah@gmail.com Never X @
-]
# Upload user pictures lqbal Safria Iqbalsatia@gmail.com Never X @
N #*
» Permissions
M Taufik Hidayatullah M TaufikHidayatullah@gmail.com Never X @
b Courses &
) Grades M. Qazuini Muzahar M. QozuiniMuzahar@gmail.com Never X @
-
» Badges MelisaErfiana Erfiona MeliscErfianaErfiana@gmail.com Never X @
&
b Location
Muhammad Aldi Joko Satria P MuhammadAldi Joko Satria P@gmail.com Never X @
» Language &
. Niki Aldi Putra NikiAldi Putra@gmail.com Never X @
» Plugins
&*
» Security Nisa Nabila NisaNabila@gmail.com Never X @
L2
} Appearance
op Puthut Harmantyo Pangestu Aji PuthutHarmantyo Pangestu Aji@gmail.com Never X @
» Front page »
RadhityaYunandri Hartanta Yunandri RadhityaYunandri HartantaYunandri Never X @
b Server Hartanta Hartanta@gmail.com o

Gambar 4.7 Halaman User



Gambar 4.7 merupakan halaman menu user. Menu user terdiri dari beberapa

submenu yang berfungsi untuk menambahkan mahasiswa dan mengatur segala sesuatu

terkait dengan kebutuhan ataupun hak akses user. Adapun beberapa menu tersebut

adalah sebagai berikut:

1.

Browse list of user: Menu untuk melihat user yang telah ditambahkan pada
website.

Bulk user action: Menu untuk menghapus dan merubah password user.

Add new user: Menu untuk menambahkan user baru.

User default user preference: Menu untuk mengatur tampilan email dan
postingan user.

User profile fields: Menu untuk membuat profile fields user berdasarkan pilihan
Dropdown menu, Text area, Text input, Check box dan date and time.

Cohorts : Menu untuk membuat kelompok user

Upload user : Menu untuk menambahkan banyak user melalui file Microsoft
exel

Upload user picture: Menu untuk menambah photo profile user.
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4.3.1.7. Menu Courses and Category

Admin User e =
G ELNA

(Gamma Feedback Lenrning Model>
Research and Development

Dashboard » Site administration » Courses » Manage courses and categories » Teknologi informasi

Navigation 2lg] Course and Cofegory mgnqgemenT Viewing: Course categories and courses=
BESieee] Course categories Teknologi informasi
= Site home Create new category Create new course | Sorf courses™ | Per page: 20~
» Site pages O - Teknologiinformasi @ % #- 1% #0 Javo #xo
» Courses O = Kesehatan @ B~ ow
Showing all 1 courses
Sorfing Move selected courses fo...

Administration S]] Selected categories B hesen m

Sort by Category name ascending
+ Category: Teknologi informasi

S gy Sort by Course full name ascending

2 Edit this category n

[Eddloitecgieocn) Move selected categories to

2. Assign roles Choose.. m

A Permissions

2. Check permissions
i Cohorts

Y Fitters

& Restore course

~ Site administration
Search courses:
£ Notifications

Gambar 4.8 Menu Courses and Category

Gambar 4.8 merupakan menu courses and category berfungsi untuk mengatur
mata kuliah dan topik perkuliahan yang telah dibuat. Beberapa menu yang terdapat
pada menu courses and category adalah sebagai berikut:

1. Manage courses and category: Menu yang berfungsi untuk menambahkan,
mengurutkan dan menghapus topik perkuliahan.

2. Add category: Menu untuk menambahkan kategori dari mata kuliah yang telah
dibuat.

3. Restore course: Menu untuk mengembalikan matakuliah yang pernah dibackup
sebelumnya.
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4. Courses default setting: Menu untuk mengatur tampilan mata kuliah, format
mata kuliah dan maksimal data file unggahan.

5. Courses request : Menu yang digunakan oleh siswa untuk meminta courses
yang belum terdapat pada website, menu ini hanya bisa digunakan jika telah
diaktifkan oleh admin

6. Upload courses: Menu yang berfungsi untuk mengupload courses yang telah

dibuat melalui microsoft exel dengan format .csv.
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4.3.1.7. Menu Grades

Admin User e =

(Gamma Feedback Learning Model >
Research and Development

Dashboard » Site administrafion » Grades » General setfings Blocks editing on

Navigation @@ General settings
O Manager
Graded roles
Dashboard secesonoe. L] Course creator
: [ Teacher
® Site home [ Non-editing teacher
Student
» Site pages O Guest
[ Authenticated user
» Courses [0 Authenticated user on frontpage
Default: Student
This setting allows you to control who appears on the gradsbock. Users need to have at least one of
these roles in @ course fo be shown in the gradebook for that course.
Administrati 2lg]
User profile report | User report Default: User report
. . . orade._profiersport
~ Site administration Grade report usad on user profile page.
% Notifications
& Registration Aggregation position | Last E| Default: Last
grade_aggregatfionposifion
O PSR TS This setting determines whether the category and course fotal columns are displayed first or last in the
gradebook reports.
b Users
Default: Yes
» Courses Include scales i i
ne ”,::::fs " :9;‘2'9?“_‘12 You can change whether scales are to be included as numbers in all aggregated grades across all
S — IPREMEEREEEnAIEITET  debooks in all courses. CAUTION: changing 1his setfing will force all aggregated grades to be
recalculated.
4# General seffings
. O Default: No
sh bmitted date for hidds
& Grade category settings ow submitied date for g‘m ;‘:s If user can not see hidden grades show date of submission instead of -
% Grade item seftings grade_hicdenasdate
R Scoles [0 Defauli: No
Enable publishing . . i i
2 Lot S Enable publishing in exports and imports: Exported grades can be accessed by accesing a URL, without
L I peving to log on to @ Moodile site. Grades can be imported by accesing such a URL [which means that
N —— a Moodile site can import grades published by another site). By default only administrators may use this
EEEUSHULIEE feature, please educate users before adding required capabiliies 1o other roles (dangers of bockmark
» Badges sharing and download accelerators, IF restrictions, etc.).
» Location
Grade export display type | Real Default: Real
» Language grads_sxport_displaytype
Grades can be shown os real grades, as percentages (in raference fo fhe minimum and maximum
» Plugins grades) or as lefters (A, B, C efc..) during export. This can be overidden during export.
» Security
Grade export decimal points 2 B Default: 2
» Appearance grade_export_decimalpoints
The number of decimal points to display for export. This can be overridden during export.
» Front page

Gambar 4.9 Menu Grades

Gambar 4.9 merupakan halaman menu grades. Menu grades berfungsi untuk
mengatur semua hal terkait tampilan dan fungsi yang berada pada halaman grades

mahasiswa.
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4.3.1.8. Menu Language
Gambar 4.10 merupakan halaman menu language. Menu language berfungsi

untuk mengatur menu language yang akan ditampilkan pada halaman web user. Menu
yang terdapat pada halaman language adalah sebagai berikut:

1. Language settings: Menu vyang berfungsi untuk mengaktifkan atau
menonaktifkan menu pemilihan bahasa pada website dan memilih pengunaan

bahasa pada website.

2. Language packs: Menu yang berfungsi untuk mengimpor paket bahasa

kedalam website. Menu ini juga berfungsi untuk menghapus bahasa yang

terdapat pada menu pemilihan bahasa.

GEL

(Gamma Feedback Lenrning Model>
Research and Development

Dashboard » Site administration » Language » Language setfings

Navigation

Dashboard
® Site home
» Site pages

» Courses

Administration

~ Site administration
% Notifications
£ Registration
¥ Advanced features
b Users
b Courses
» Grades
» Badges
» Location

~ Lanauaae

@@  Language settings

Language autodatect

autolang
Default language

Display language menu
]l angmenu

Languages on language menu

langist

Cache language menu

Cache all language strings

langstingcache

Admin User e =

Blocks editing on

Default: Yes
Detect default language from browser setting, if disabled site default is used.

Default: English (en)

Choose a default language for the whole site. Users can override this setfing using the language menu
or the setting in their persenal profile.

English [en)

[0 Default: Yes
Choose whether or not you want to display the general-purpose language menu on the home page,
login page etc. This does not affect the user's ability to set the preferred language in their own profile.

Default: Empty

Leave this biank to aliow users fo choose from any language you have in this installation of Moodle.
However, you can shorten the language menu by entering o comma-separated list of language codes
that you want. For example: en,es_es.ir.it

Default: Yes
Cache the language menu. If enabled, the list of available fransiations is cached. The cache is
autornatically refreshed when you install or delete a language pack via the in-built language packs

management fool. If you install @ new language pack manually, you have to use Purge all caches
feature to refresh the cached list.

Default; Yes
Caches all the language strings info compiled files in the data directory. If you are franslating Moodile or

changing stiings in the Moodlle source code then you may want to switch this off. Othenwise leave it on
1o see performance benefits.

Gambar 4.10 Menu Language

14



4.3.1.9. Menu Appearance

Admin User e =

(Gamma Feedback Learning Model >
Research and Development

Dashboard » Site administrafion » Appearance » Themes » Theme settings

Navigation

Dashboard
® Site home
» Site pages

» Courses

Administration

v Site administration
£ Notifications
£# Registration
# Advanced features
» Users
» Courses
» Grades
» Badges
» Location
» Language
» Plugins
» Security
¥ Appearance
~ Themes
£ Theme settings
4 Theme selector
» Academi
% Clean
£ More
£ Calendar
% Blog
% Navigation
£ HTML settings

4 Media embedding

2@

2@

Theme settings

Theme list
themeist

Theme designer mode
themedesignermode

Allow user themes
allowuserthemes

Allow course themes

allowcoursethemes

Allow category themes
allowcategorythemess

Allow theme changes in the URL
allowthemechangeonud

Allow users to hidle blocks
allowuserblockhiding

Allow blocks to use the dock
allowblockstodock

Custom menu items
custormentitems

Blocks editing on

Default: Emply

Leave this blank to allow any valid theme to be used. If you want to sharten the theme menu, you can
specify a comma-separated list of names here (Don't use spaces!). For example: standard,orangewhite.

0O Default: No

Normally cll theme images and style sheets are cached in browsers and on the server for a very long
fime, for performance. If you are designing themes or developing code then you probably want to tum
this mode on so that you are not served cached versions. Warming: this will make your site slower for all
users! Alternatively, you can alse reset the theme caches manually from the Theme selection page.

O Default: No
If you enable this, then users will be allowed 1o set their own themes. User themes override site themes
(but not course themes)

[0 Defauli: No
If you enable this, then courses will be allowed to set their own themes. Course themes override all other
theme choices (site, user, or session themes)

O Default: No

If you enable this, then themes can be set at the category level. This will affect all child categoeries and
courses unless they have specifically set their own theme. WARNING: Enabling category themes may
affect performance.

O Default: No

If enabled, the theme can be changed by adding sither:

?theme=themename to any Moodle URL (eg: mymoodiesite.com/Ztheme=afterburner ) or
&theme=themename to any internal Moodle URL [eg: mymoodiasite.com/course/view.phpid=28
theme=afterbumer ).

Default: Yes
Do you want te allow users to hide/show side blocks throughout this site? This feature uses Javascript and
cookies to remember the state of each collapsible block, and only affects the user's own view.

Default: Yes
If enabled and supported by the selected theme users can choose to move blocks o a special dock.

Default: Empty

You can configure a custom menu here 1o be shown by themes. Each line consists of some menu fext, a
link URL {optional, a tooltip fitle {optienal) and a language code or comma-separated list of codes
(optional, for displaying the line to users of the specified language only), separated by pipe characters.
You can specify a siructure using hyphens, and dividers can be used by adding a line of one or more #
characters where desired. For example:

Gambar 4.11 Menu Appearance
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Gambar 4.11 merupakan halaman menu appearance. Menu Appearance

berfungsi untuk mengatur tampilan halaman website secara keseluruhan. Beberapa sub

menu yang terdapat pada halaman apperance adalah sebagai berikut:

1.

Themes : Menu yang berfungsi untuk mengatur semua fungsi dalam tema,
seperti mengganti icon, gambar dalam slider, mengganti informasi footer dan
header, merubah warna tema yang digunakan, merubah font, merubah ukuran
font dan mengganti tema bawaan dengan tema yang telah dibuat sendiri atau
mengunakan tema open source.

Calendar: Menu yang berfungsi untuk mengatur tampilan kalender block
kalender didalam website. Pengaturan yang terdapat pada menu calendar
adalah pengaturan tipe kalender, format waktu, penetapan hari libur dan event
yang akan ditampilkan pada kalender

Navigation : Menu yang mengatur tampilan blok navigasi, terkait isi blok
navigasi dan pengaktifan dan penonaktifan fungsi pada blok navigasi

Default dashboard page: Menu yang berfungsi untuk menambahkan atau
mengahapus block yang akan digunakan pada halaman dashboard user.
Additional HTML: Menu yang berfungsi untuk penambahan konten HTML

pada tampilan halaman web user.
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4.3.1.10. Menu Front Page

Gambar 4.12 merupakan halaman menu front page. Menu front page berfungsi
untuk mengatur tampilan halaman beranda user, seperti merubah nama website,
merubah nama website pada tab browser, menambahkan summary pada halaman
beranda, penambahan list category dan list courses.

Admin User e =

Research and Development
Dashboard » Front page setfings » Edif setings
Navigation Sl Front page settings
PICT
Dashboard fullste name
= Site home
} Site pages Short name for site (eg single word) iplct
b Courses
Front page summary B W B | I EIE || P | 22| |
summary
Administration Slal
~ Front page settings
# Tum editing on
+* Edit settings
» Users
T Filters
» Reports
& Backup This summary can be displayed on the front page using the course/site summary block.
& Restore
Frontpage | Ustof cotegeries  |v
» Question bank frontpage
MNone A
~ Site administration
B
£+ Notifications
£ Registration None
& Advanced features Mone "
» Users . ' " "
The items selectad above will be displayed on the site's front page.
» Courses
» Grades Front page iterms when logged in List of courses
. i
b Badges None w
» Location
None ~
» Language
» Plugins Hone ¥
» Security None v
b Appearance
MNone A

~ Front page
The items selectad above will be displayed on the site’s front page when a user s logged In
4 Front page seftings

» Server

Maximum category depth | 5

axcategorydepth

¥| Default: 2

b Reports This specifies the maximum depth of child categories expanded when displaying categories or combo

list. Deeper level categories will appear as links and user can expand them with AJAX request.
b Navalnnmant

Gambar 4.12 Menu Front page

17



4.3.2. Halaman User

Halaman user adalah halaman yang tampilan dan fungsinya telah diatur oleh
administrator, Halaman user pada website Ilmuku.com menggunakan akitivitas kuis
sebagai penampung nilai mahasiswa beserta paket SCORM yang berisi materi

perkuliahan dan soal-soal terkait materi perkuliahan.

4.3.2.1. Halaman Dashboard User

Navigation Course overview

Dashboard
Site home
Site pages
My courses

java

Gambar 4.13 Halaman Dashboard User

Gambar 4.13 merupakan Halaman Dashboard user. Halaman Dashboard user
terdiri dari block Navigation dan block courses overview. Courses overview hanya
memuat mata kuliah yang diikuti oleh mahasiswa. Block Navigation terdiri dari

beberapa menu yaitu:
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1. Site home: Menu yang mengalihkan mahasiswa ke halaman home.

2. Site Pages: Menu yang berisi beberapa submenu seperti:

- Site blog: berfungsi untuk membuat blog terkait perkuliahan sebagai
sarana pertukaran informasi antar mahasiswa. Site blog memiliki fitur
untuk menambahkan file seperti pdf, audio dan video.

- Tags: berfungsi untuk mencari informasi berdasarkan tag pada tulisan
yang telah dibuat sebelumnya.

- Calender: berfungsi untuk melihat event yang telah dibuat oleh
administrator.

3. My Courses: Menu yang berisi mata kuliah yang diikuti oleh mahasiswa. Menu
digunakan oleh mahasiswa untuk mengakses halaman topik perkuliahan.
Halaman topik perkuliahan berisi materi perkuliahan yang dimuat di dalam
paket SCORM. halaman topik perkuliahan mahasiswa dapat dilihat pada
gambar 4.13.
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4.3.2.2. Halaman profile

Halaman profile mahasiswa berisi informasi data mahasiswa, data mata kuliah
yang diikuti oleh mahasiswa dan login activity. Mahasiswa memiliki hak akses untuk
merubah data yang sebelumnya telah dibuat oleh admin website seperti merubah
alamat email dan mengunggah profile picture. Halaman Profile dapat dilihat pada
gambar 4.14.

Navigation

Dashboard
Course details Login acti
Site home Course profiles First access fo site
- Friday, 19 May 2017, 619 PM (3 days 12 hours)
Site pages
Last access to site

My rse:
My courses Tuesday, 23 May 2017, 6:34 AM (now]

amantirto, Kasihan,

Gambar 4.14 Halaman Profile
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4.3.2.3. Halaman Message
Halaman message adalah halaman yang digunakan mahasiswa untuk
melakukan chatting kepada sesama mahasiswa ataupun kepada dosen. Halaman

message dapat dinilai pada gambar 4.15.

o Mo
Navigatior = Message navigation:
java v
Dashboard Page: 123 (
Site home Participants
Site pages

Current course

My courses

istratior

Course administration

JL. Linkar Selatan, Tamantirto, Kasihan,

Bantul, Yogyakarta

Phone: +628179438668

&% E-mail: purbohadi@yahoo.co

Gambar 4.15 Halaman Message

21



4.4. Hasil Pengujian Website

Data pengujian website Imuku.com diperoleh dari dua metode pengujian.
Metode yang digunakan adalah metode Black box testing dan metode Real testing.
Metode Black box testing adalah metode yang digunakan untuk mengetahui
keberhasilan sistem berdasarkan butir uji yang telah dibuat, sedangkan metode Real
testing adalah metode yang digunakan untuk mengetahui tingkat kelayakan sistem

berdasarkan data kuisoner yang telah diisi oleh responden.

4.4.1. Hasil Black Box Testing
Hasil yang di dapat dari pengujian Black box yang telah dilakukan dapat dilihat
pada tabel 4.1.

No Butir uji Hasil yang Hasil yang didapat | Status

diharapkan

1 | Menerima Data nilai mahasiswa | Data nilai mahasiswa | Berhasil
data nilai | dari paket SCORM | telah terinput
mahasiswa (modul mahasiswa) | kedalam  database

akan terinput kedalam | Moodle.
database Moodle.

2 | Menampilkan | Data nilai mahasiswa | Data nilai mahasiswa | Berhasil
data nilai | akan ditampilkan di | dapat tampil di
mahasiswa halaman grade. halaman grade.

3 | Mengirim Data nilai mahasiswa | Data nilai mahasiswa | Berhasil
data nilai | dapat di kirim ke paket | terkirim.
mahasiswa SCORM (modul

dosen).

4 | Mengunggah | Paket SCORM (modul | Paket SCORM | Berhasil
modul mahasiswa) dapat | (modul mahasiswa)
mahasiswa diunggah di halaman | telah terunggah

course. dihalaman course.

5 | Menampilkan | Total nilai mahasiswa | Total nilai | Belum
total nilai | dapat ditampilkan pada | mahasiswa  belum | Berhasil
mahasiswa halaman grade. dapat ditampilkan
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Tabel 4.1 Hasil pengujian Black Box.

4.4.2.Hasil Real Testing (Kuesioner)

Data hasil kuesioner menunjukan kelayakan sistem dari Website IImuku.com
yang telah dibuat. Kelayakan dihitung dari perbandingan jumlah data yang didapat
dengan jumlah data keseuruhan. Berikut adalah diagram hasil kuisoner dari metode
Real testing:

SOAL 1

W Sangat setuju M Setuju M Kurangsetuju m Tidak setuju

Diagram 4.1 Teks mudah dibaca dan bebas dari kesalahan penulisan

Diagram 4.1. merupakan data hasil penilaian responden terhadap soal nomor 1.
Diagram 4.1. menunjukan bahwa 80% responden setuju bahwa teks pada website
mudah dibaca dan bebas dari kesalahan, 15% responden menyatakan sangat setuju dan
5% atau satu responden menyatakan kurang setuju.
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SOAL 2

M Sangat setuju M Setuju M Kurang setuju mTidak setuju

Diagram 4.2 Warna dan font yang digunakan pada website

Diagram 4.2. merupakan hasil penilaian responden terhadap soal nomor 2. Dari
diagram tersebut ada 80% responden menyatakan setuju dan 20% menyatakan sangat

setuju bahwa warna dan font yang digunakan pada website telah sesuai.
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SOAL3

MW Sangat setuju  mSetuju mKurangsetuju mTidak setuju

Diagram 4.3 User interface pada website mudah dimengerti

Diagram 4.3 merupakan data hasil penilain responden terhadap soal nomor 3,
dari diagram tersebut dapat dilihat 85 % responden setuju dan 15 % responden

menyatakan sangat setuju bahwa user interface pada website mudah dimengerti.
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SOAL 4

MW Sangat setuju  mSetuju mKurangsetuju mTidak setuju

Diagram 4.4 User interface pada website mudah dimengerti

Diagram 4.4. merupakan hasil penilaian responden terhadap soal nomor 4, dari
diagram tersebut diperoleh data 75% responden setuju bahwa user inteface pada
website mudah dimengerti,20% sangat setuju sedangkan 5% atau 1 orang kurang

setuju.
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SOALS

MW Sangat setuju  mSetuju mKurangsetuju mTidak setuju

Diagram 4.5 Fungsi dalam website telah memenuhi kebetuhan pengguna

Diagram 4.5 adalah hasil penilain responden terhadap soal nomor 5, pada
diagram tersebut dapat dilihat bahwa ada 90% dari keseuruhan responden setuju dan

10% sangat setuju bahwa fungsi dalam website telah memenuhi kebutuhan pengguna.
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SOAL 6

MW Sangat setuju  mSetuju mKurangsetuju mTidak setuju

Diagram 4.6 Tombol konsisten dengan fungsi

Diagram 4.6 merupakan hasil penilaian responden terhadap soal nomor 6, dari
diagram tersebut dapat dilihat bahwa ada 90% responden setuju dan 10 % sangat setuju
bahwa tombol telah konsisten dengan fungsi.

Dari data responden terhadap website ilmuku.com dapat diambil kesimpulan
bahwa secara keseluruhan website ilmuku.com telah berfungsi dengan baik sehingga

mampu memberikan tingkat kelayakan dan kepuasan terhadap pengguna.
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